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General Instructions: 1. You are aware that evaluation is the most important process in the actual and correct assessment of the
candidates. A small mistake in evaluation may lead to serious problems which may affect the future of the
candidates, education system and teaching profession. To avoid mistakes, it is requested that before starting
evaluation, you must read and understand the spot evaluation guidelines carefully.Evaluation is a 10-12 days
mission for all of us. Hence, it is necessary that you put in your best effortsin this process.
2. Evaluation is to be done as per instructions provided in the Marking Scheme. It should not be done according
to one’s own interpretation or any other consideration. Marking Scheme should be strictly adhered to and
religiously followed. However, while evaluating, answers which are based on latest information or
knowledge and/or are innovative, they may be assessed for their correctness otherwise and marks be
awarded to them. In class-X, while evaluating two competency based questions, please try to
understand given answer and even if reply is not from marking scheme but correct competency is
enumerated by the candidate, marks should be awarded.
3. The Head-Examiner must go through the first five answer books evaluated by each evaluator on the first day,
to ensure that evaluation has been carried out as per the instructions given in the Marking Scheme. The
remaining answer books meant for evaluation shall be given only after ensuring that there is no significant
variation in the marking of individual evaluators.
4. Evaluators will mark( √ ) wherever answer is correct. For wrong answer ‘X”be marked. Evaluators will not put
right kind of mark while evaluating which gives an impression that answer is correct and no marks are awarded.
This is most common mistake which evaluators are committing.
5. If a question has parts, please award marks on the right-hand side for each part. Marks awarded for different
parts of the question should then be totaled up and written in the left-hand margin and encircled. This may be
followed strictly.
6. If a question does not have any parts, marks must be awarded in the left-hand margin and encircled. This may
also be followed strictly.
7. If a student has attempted an extra question, answer of the question deserving more marks should be retained
and the other answer scored out.
8. No marks to be deducted for the cumulative effect of an error. It should be penalized only once.
9. A full scale of marks 0-50 has to be used. Please do not hesitate to award full marks if the
answer if the answer deserves it.
10. Every examiner has to necessarily do evaluation work for full working hours i.e. 8 hours every day and evaluate
20 answer books per day in main subjects and 25 answer books per day in other subjects (Details are given
in Spot Guidelines).
11. Ensure that you do not make the following common types of errors committed by the Examiner in the past:• Leaving answer or part thereof unassessed in an answer book.
• Giving more marks for an answer than assigned to it.
• Wrong totaling of marks awarded on a reply.
• Wrong transfer of marks from the inside pages of the answer book to the title page.
• Wrong question wise totaling on the title page.
• Wrong totaling of marks of the two columns on the title page.
• Wrong grand total.
• Marks in words and figures not tallying.
• Wrong transfer of marks from the answer book to online award list.
• Answers marked as correct, but marks not awarded. (Ensure that the right tick mark is correctly and clearly
indicated. It should merely be a line. Same is with the X for incorrect answer.)
• Half or a part of answer marked correct and the rest as wrong, but no marks awarded.
12. While evaluating the answer books if the answer is found to be totally incorrect, it should be marked as cross
(X) and awarded zero (0)Marks.
1

13. Any unassessed portion, non-carrying over of marks to the title page, or totaling error detected by the candidate
shall damage the prestige of all the personnel engaged in the evaluation work as also of the Board. Hence, in
order to uphold the prestige of all concerned, it is again reiterated that the instructions be followed meticulously
and judiciously.
14. The Examiners should acquaint themselves with the guidelines given in the Guidelines for spot Evaluation
before starting the actual evaluation.

15. Every Examiner shall also ensure that all the answers are evaluated, marks carried over to the title page,
correctly totaled and written in figures and words.
16. The Board permits candidates to obtain photocopy of the Answer Book on request in an RTI application and
also separately as a part of the re-evaluation process on payment of the processing charges.
17. Please Make Note of the following points for internal choice Questions
Section A – (10 Marks)
a) Q1 to Q 6 are of 1 mark each but only 4 out of 6 are to be attempted.
b) Q7 to Q 11 is of 2 marks each but only 3 out of 5 are to be attempted.
Section B – (40 Marks)
c) Q12 to Q 23 is of 1 mark each but only 10 out of 12 are to be attempted.
d) Q24 to Q 29 is of 2 marks each but only 4 out of 6 are to be attempted.
e) Q30 to Q 35 is of 3 marks each but only 4 out of 6 are to be attempted.
f) Q36 to Q 39 is of 5 marks each but only 2 out of 4 are to be attempted.
Correct answers to be marked, irrespective of the order of answering questions,
ignore wrong/half correct answer if more than needed are answered

S.NO

SECTION A (Employability Skills)
10 Marks
Question

Answer any 4 questions out of the given 6 questions of 1 mark each
1
Ans
2
Ans

3
Ans

4
Ans
5
Ans

______________ are a group of words that work together to communicate
an element of speech
Phrases/Sentences/Messages/Statements
1 mark for the above answer.
______________ refers to focusing human efforts for maintaining a
healthy body and mind capable of better withstanding stressful situations
Stress Management / Yoga / Meditation /Exercise /Vacations with friends
and family /Taking Nature walks
1 mark for the above answer.
Having conscious knowledge of your own self capabilities, feelings and
one's own character is called as ______________
Awareness / Confidence / Consciousness / Esteem
(use of word ‘Self ‘, ‘External’ or ‘Internal’ with the above words should
also be considered)
1 mark for the above answer
A ______________ is a software that helps you type and work with text on
a computer (word processor/ spreadsheet/ calculator)
Word Processor
1 mark for the above answer
Entrepreneurs are not job seekers but they create opportunities of
employment for people. (True/False)
True
2

Marks

1*4 = 4
1

1

1

1

1

6

Ans

1 mark for the above answer
______________ defines a green economy as one that results in
“improved human well being and social equity while significantly reducing
environmental risk and ecological scarcities”.
United Nations Environment Programme / UNEP / Sustainable
Development / Green skills
1 mark for the above answer.
½ mark for writing UN or United Nation Only

Answer any 3 questions out of the given 5 questions of 2 marks each
7
Ans

8
Ans

Explain four types of sentences in English
There are four types of sentences in the English language.
1. Imperative- gives a command (.)
2. Assertive / Declarative- makes a statement (.)
3. Interrogative- asks a question (?)
4. Exclamatory- expresses strong feelings (!)
½ mark for each above type of sentence
OR
1. Simple
2. Compound
3. Complex
above three can also be considered as different types of sentences
OR
Any four different types of examples should also be considered full marks
List any four characteristics of entrepreneurship.

1

2*3 = 6
2

2

(Any four from the following)
Ambition, Confidence, Willingness, Ability to learn from mistakes, Trust
and respect for the team, Self-Motivation, Leadership , Risk taking ,
Optimistic , Innovative, Goal oriented, Vision, Creativity, Motivator,
Decision maker, Strong work ethics, Action oriented, Disciplined, Dynamic
agent, Skill, Knowledge etc.

9
Ans

OR
Any other characteristics of entrepreneurship
½ mark for each correct characteristics
Write steps to highlight text in an OpenOffice Writer.
Select the text and click on
text) in the Font group.

icon (font colour) /
OR

Select the text which you want to highlight and
click

(or Press Ctrl+B)

OR
Select the text which you want to highlight and
click

(or Press Ctrl+I)
OR
3

2
(highlighting

Select the text which you want to highlight and
click

10
Ans

11
Ans

(or Press Ctrl+U)

OR
Select the text with help of Keyboard / Mouse
OR
Any other option that makes text appear distinct from the rest of the text.
2 marks for any above Option
List any two factors that affect self-confidence.
1. Childhood
2. Family
3. Friends
4. Work
5. Environment
6. Society
7. Media
8. Spirituality/Yoga/Meditation/Exercise
9. Relationships
10. Health
11. Academics
12. Self-belief
13. Stress
OR
Any other relevant factor
1 mark for each factor
List any four factors causing ecological imbalance.
The various factors causing ecological imbalance are as follows:
1. destruction of forests /Deforestation
2. Industrialization/ Factories
3. Urbanization
4. Large scale use of pesticides
5. overgrazing
6. degradation of land / Soil erosion
7. Faulty utilization of water resources
8.Environmental problems from faulty mining practices
9. Pollution
10. Population/Over population
11. Excessive of Technologies
OR
any other relevant factor causing ecological imbalance
½ mark for each factor (any four)
SECTION B (SUBJECT SKILLS)
(40 Marks)

Answer any 10 questions out of the given 12 questions of 1 mark each
12

When a combination of hardware and software enables a person with a
disability or impairment to use a computer it is known as:
(A) Mechanical assistance
(B) Assertiveness
4

2

2

1*10=10
1

18

(C) Assistive Technology
(D) Assistance and communication
Assistive Technology
1 mark for the above answer
______________ in control panel are used to customize the way your
keyboard, display or mouse function
Accessibility Options /Ease of Access
1 mark for the above answer
Picture and clip art options are available under ______________
Insert Tab /Illustrations Group
1 mark for the abovet answer
Header option is available under ______________ group in insert tab
Header & Footer
1 mark for the above answer
______________is one of the functions available in the spreadsheet to
perform addition of selected numbers in the sheet
Sum/Autosum
1 mark for the above answer
Autosum automatically select the values around the cells either
______________ or ______________
Horizontally, Vertically
OR
Rows, Columns
½ mark each for above answer
Layout option is available under ______________ group in the home tab

Ans

Slides/ New slide layout

Ans
13
Ans
14
Ans
15
Ans
16
Ans
17
Ans

19
Ans
20
Ans

21
Ans
22
Ans

OR
Page Setup (*consider this answer because software is not mentioned)
1 mark for the above answer
Presentation software enables the user to add tables in the slide in order
to represent the ______________ data meaningfully
Statistical /Raw / Tabular / Comparative / Simple
1 mark for any relevant answer
Time management is the act of planning to stay organized that will result
in increased ______________ and ______________
Productivity, Efficiency, Strength, Capability
OR
any other relevant answers
½ mark for each above answer
______________ appointments can be used for scheduling repetitive tasks
Recurring / Business / Daily / Weekly / Monthly / Yearly
1 mark for the above answer
______________ statement is used to add one or more records to a
database
INSERT
OR
Insert > Row
5

1

1

1

1

1

1

1

1

1

1

OR
Right-click on any Row > New Row
OR
Ctrl + [+]

23
Ans

1 mark for each correct
*Note: if student write remark like “wrong question”, “incomplete
question” then award full marks
______________ statement retrieves zero or more rows from one or more
database tables
SELECT
OR
Double click on the table Name
OR
Right Click on Table Name > Open
1 mark for the correct answer

Answer any 4 questions out of the given 6 questions of 2 marks each
24
Ans

25

Explain blog. Give any two websites that offer free blog services
A blog is a discussion style site used by non-technical (or technical users)
users for creating personal web pages.
OR
Blogs are similar to an online personal diary and simple to use.
OR
We can use a blog to convey messages about events, announcements,
news, reviews, etc.
OR
A website where a person writes regularly about topics that interest them,
with photograph or text
OR
Some of the popular websites that offer free blog services include:
1. www.WordPress.com
2. www.blogger.com
3. www.blog.com
4. www.weebly.com
5. www.blogsome.com
6. www.tumblr.com
7. www.wix.com
8. www.joomla.com
9. www.medium.com
10. www.ghost.com
Note: i) If in place of definition of Blog if candidate writes, how to use
blog, it should also be considered.
ii) Any correct website apart from the above-mentioned website that
offer free blog services should also be considered
1 mark for definition of blog
½ mark each for naming correct websites
List any four items that may be added in the Header area.

Ans

(Any four from the following items)
•

Picture
6

1

2*4 = 8
2

2

26
Ans

• Page number
• Number of Pages
• Date
• Time
• File Path
• File Name
• Sheet name
• Name of the author
• Company or Department Name
Any other relevant answers can be considered.
½ mark each for naming correct items
List any two conditions/ formats/items that can be used for conditional
formatting in a Spreadsheet
(Any Two from the following conditions /Formats/Items)
We can control the following formats by using following options:

2

Conditions:
• Less than (<)
• greater than (>)
• less than equal to (<=)
• greater than equal to (>=)
• equals to (=)
• not equals to (! =, < >)
• Between
• Not Between
• Top Ten
• Bottom Ten
• Above Average
• Below Average
• Text that Contains
etc.

Formats:
• Number format
• Font
• Font style
• Font color
• Fill color
• Fill pattern
• Border color
• Border style
(but not border thickness)
etc
Items:
• Highlight cell rules
• Top/Bottom Rules
• Data Bars
• Colour scales
• Icon Sets
etc.
1 mark each for listing correct conditions/ formats/items

27

Mention two ways in which a movie file may be inserted in a presentation

2

Ans

28

(Any Two from the following ways)
A movie file can be inserted in following ways:
• Using Insert Tab
• Using Title and Content Layout Option
• Using Insert > movie > from file
• Using Insert > movie > Clip Organizer
• Using Insert > movie > Online videos
• By Copy and Paste movie file
• By Cut and Paste movie file
• By Drag and Drop movie file
1 mark for each correct way
Mention two ways of scheduling an appointment.

2

Ans

You can schedule an appointment in two ways:
7

29
Ans

1. Using Menu bar.
2. Using calendar view
3. Calendar > Home tab > New appointment
4. Using Daily / Weekly / Monthly / Yearly
1 mark each for each correct method
Explain two types of languages used for creating and manipulating the
data in databases.
DDL/Data Definition Language/ Data Description Language: which work on
the structure of table and it consist of following statements: CREATE,
ALTER, and DROP.
DML/Data Manipulation language: which work on the content of table and
it consist of following statements: INSERT, UPDATE, DELETE
1 mark each for the DDL and DML or full form or explanation
1 mark each for writing only DDL and DML with example
OR
(Any two from the following)
• Oracle
• MySQL
• SQL
• MS Access
• dBase
• FoxPro
etc.
1 mark each for the correct example

Answer any 4 questions out of given 6 questions of 3 marks each
30
Ans

What are section breaks? Explain how a section break helps in formatting
a document.
Section breaks can be used to separate a document into sections.
OR
To separate a section in a document, you can use the section break.
OR
A section break controls the formatting of the document content that
precedes it, until it reaches another section break.
1.5 marks for any above section break definition
(Any one from the following ways)
Section break help in following ways:
• Add flexibility to formatting a document.
• We can create different footnote numbering, change the layout of
columns, change page borders for different pages, and even
change page layouts in the same document.
• Using section breaks is like having mini-documents in one large
document.
• We can separate the chapters as separate sections in our
document so that the page numbering for each chapter begins at 1.

8

2
1

1

3*4 = 12
3

1½

1½

•

31

Ans

We can also create a different header or footer for a section of our
document.
1.5 marks for any correct use
Differentiate between linking and embedding a document. Does embedding
a document increase the size of the document? List any two websites that
offer free clipart.
(Any one from the following)
• Embedding an object makes it part of the document while linking
an object does not include the object file into the document files.
• Users trying to access the linked object must also have direct
access to the separate file that forms that object.
• Linking means change in source file reflected in the target file but
Embedding means change in source file does not reflect in the
target file.
1 mark for correct difference
Yes, embedding a document increases the size of the document.
1 mark for answer

32
Ans

(Any two from the following examples)
Some of the websites that have free clip arts are:
• www.openclipart.org
• www.pdclipart.org
• www.clker.com
• www.freeclipartnow.com
• www.wpclipart.com
• www.webweavers.com
• www. Vecteezy.com
• www.vertvex.com
• www.clipartlord.com
Note: Any other correct website that offer free clipart should also be
considered
½ mark each for naming above websites
Give any three basic guidelines for charts in a presentation.
(Any three from the following guidelines)
Some Basic guidelines are as follows:
• Convey one message per chart.
• Make the message the heading.
• Make the chart easy to read.
• Label the X and Y axis and label the lines, bars or pie wedges.
• Make the most important text largest
• Darken the most important data lines or sections.
• Make bars and columns wider than the spaces between them.
• Be accurate.
• Always start a numerical axis at zero.
• Compare only like variables.
• Eliminate all unnecessary details.
• Avoid extra grid lines, data points, boxes etc.
9

3

1

1

1

3

• Use a few (maximum four) colors per visual.
Note: any other relevant guideline can also be considered.
1 mark for each above guideline
Write steps to give transition effects in a presentation software.

3

Steps to give transition effects:
• Click on Animations Tab / Transitions Tab
• A list of transition effects will be displayed.
• Select an effect from Transitions to this slide group and doubleclick on it.
3 mark for correct answer
Explain any three data types in OpenOffice base.

3

(Any three from the following data types/examples of data types)
1) Numeric Types: - It is used for describing numeric values for the
field.
For Example: Integer, Decimal, Float, Double, Single.
2) Alphanumeric Types: - it is used to store the combination of alphabet,
numbers or special characters.
For Example: Char, Varchar, Text, Memo
3) Binary Types: it is used for describing data in binary formats.
For Example: Image, Binary, Yes/No.
4) Date & Time: it is used for describing date and time values for the field.
For Example: Date, Time, Timestamp
5) Other Variable types: it is used to describing anything from binary code
to images, sound file to another file.
For Example: Object, hyperlink, OLE Object, Lookup Wizard
Note: Writing of field name that depict different datatype may also be
given due credit.
1 mark for each Data type/Example (with or without explanation)
Explain the following with respect to Databases:

3

(a)

Forms

1

Ans

A form provides the user a systematic way of storing information into the
database.
OR
It is an interface in a user specified layout that lets users to view, enter,
and change data directly in database objects such as tables.
OR
Forms are the user-friendly interfaces that facilitates the process of
entering data in tables and queries.
1 mark for any above/relevant answer
Reports

1

33
Ans

34
Ans

35

(b)
Ans

A report is used to generate the overall work outcome in a clear format.
OR
Reports are used to display the selected data in a printable format
OR
Reports collects the summarize data from one or more tables/ queries and
organized it in a printable form
10

1 mark for any above/relevant answer
(c)

Table

1

Ans

A table is a set of data elements (values) that is organized using a model
of vertical columns (which are identified by their name) and horizontal
rows.
OR
A table is a combination of rows and columns.
OR
Tables are building blocks of a database. They store complete data in a
structured manner.
1 mark for any above/relevant answer
Note: Pictorial presentation of a table with data should also be
considered

Answer any 2 questions out of the given 4 questions of 5 marks each
36

(a)

Explain any three types of impairment that impact computer usage.

Ans

(Any three types of impairments from the following)
• There are numerous types of impairment that impact computer
usage. These include:
• Cognitive impairments and learning disabilities, such as dyslexia,
attention deficit-hyperactivity disorder (ADHD) or autism.
• Visual impairment such as low-vision, complete or partial blindness
and color blindness.
• Hearing impairment including deafness.
• Physical/Motor or dexterity impairment such as paralysis, cerebral
palsy or carpal tunnel syndrome and repetitive strain injury.
1 mark for each correct/relevant impairment
Explain Client- Server architecture and Peer to Peer architecture.

(b)
Ans

Client-Server Architecture: networks in which certain computers have
special dedicated tasks, providing services to other computers (in the
network) are called client server networks.
OR
The computer(s) which provide services are called servers and the ones
that use these services are called clients.
OR
The model of interaction between two application programs in which a
program(client) request a service from a program at the other end (server)
1 mark for any above explanation
Peer-to-peer (P2P) Architecture: Networks in which all computers have an
equal status are called peer to peer networks.
OR
In peer to peer network each terminal has an equally competent CPU.
OR
Network in which one computer is connected to another computer directly
OR
When two or more computer connected to each other and there is no client
and server between them.
1 mark for any above explanation
11

5*2 = 10
1+1+1

1+1

37
(a)

Given the following spreadsheet write the appropriate formula/ function
/expression to be used for (a) to (e):
Write the formula to calculate the Total sales of North Zone

Ans

= SUM (B3:E3)

5
1

OR
= SUM (B3, C3, D3, E3)
OR
= (B3+C3+D3+E3)
OR
Select F3 cell and press Autosum icon
1 mark for any above answer
Write the feature used for arranging the Sales from Lowest to the Highest

1

(c)

SORT / SORTING / A to Z Icon
1 mark for the correct answer
To find the Maximum Sales in East zone

1

Ans

=MAX (B5:E5)

(d)

1 mark for the correct answer
To find the average sales in Jan-Mar in cell C7

Ans

=AVERAGE (B3:B6)

(b)
Ans

1

OR
=SUM (B3:B6)/4
OR

(e)
Ans

= (B3+B4+B5+B6)/4
Note: In place of cell range B3:B6, C3:C6 may also be considered
1 mark for the correct answer
To find the difference between the sales in East zone and West zone in
Apr- Jun.
= C5 – C4
1 mark for above answer

(c)

Note: For all the part of question No. 37
i) Ignore “=” operator before the function
ii) ½ mark should be awarded for writing only function name
without cell range
Rashika is preparing a presentation to give an annual sales report and the
progress made by the zonal teams she has to do the following in the
presentation suggest appropriate measures to do so
She wants to show the sales data in a pictorial form which tool /option she
should use to compare the data?
Charts /Graph
1 mark for the above answer
She wants to give some effect whenever the slide changes. How can she
do this?
Transition Effects /Slide Transition/ Transition/Animation Effect
1 mark for the correct answer
She has to show a table created in a spreadsheet on her slide.

Ans

Choose Object from the Insert menu.

38

(a)
Ans
(b)
Ans

12

1

5

1

1

1

(d)
Ans

(e)
Ans

39

(a)

Ans

In the Insert Object dialog box,
click the Create from File option and
click Browse to locate and choose the spreadsheet that contains the table.
OR
Copy the desired table from the spreadsheet and paste into the slide.
1 mark for any above answer
She wants to take printouts such that more than one slide is printed on
the page having only textual content.
Through Outline option
OR
File > Print > Outline
OR
Ctrl + P > Outline
1 mark for any above answer
½ marks for only “print command”
Give her an additional guideline for preparing a presentation
(Any two guidelines from the following)
• Know your topic
• Use Key phrases about the topic
• Avoid too much text on each slide
• Limit the number of slides
• Avoid fancy fonts
• Use contrasting colors for text and background
• Animation and transition must be used carefully to avoid
distraction
• Do a thorough spell check across all slides
• Remove irrelevant content such as images or clip arts, terms
• Insert speaker notes.
etc.
½ mark each for above or any other relevant guideline
Create table employee
EMPID
Char(4)
EMPNAME
Varchar(15)
DESIGN
Varchar(15)
SALARY
Decimal
CREATE TABLE Employee (
EMPID
Char(4),
EMPNAME Varchar(15),
DESIGN
Varchar(15),
SALARY
Decimal
);
1 mark for writing ‘create table employee’ command.
1 mark for writing field name with datatype
OR
• select the Create tab in the toolbar at the top of the screen.
• click on the Table Design button in the Tables group.
• add the fields to the table with desired datatype from the list
OR
• Create a table in Datasheet view
13

1

1

2

•

(b)
Ans

(c)
Ans

right-clicking the table > Click Datasheet view from the shortcut
menu.
• Add New Field column, enter the name of the fields that you
want to create.
2 marks for any of the above method of creating a table
What is a primary key?
A primary key is a unique value that identifies a row (tuple) in a table.
OR
A field (column/attribute) or set of fields (columns/attributes) which
uniquely identifies rows (tuples) in a table(relation) is called primary key.
1 mark for the any above definition
Categorize the following commands as DDL and DML:
SELECT, ALTER, INSERT, DROP
DDL: ALTER, DROP
DML: SELECT, INSERT
½ mark for each correct categorization

14
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2

